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FOREWORD 

This document is a software user’s manual for the Surrogate Safety Assessment Model (SSAM). 
It provides guidance on the installation and use of the software, which is used to perform 
surrogate safety analysis of a traffic facility, such as a signalized intersection. It does so by 
processing vehicle trajectory data from a given microscopic traffic simulation to identify the 
frequency of conflicts—where two vehicles are on a collision course and one vehicle must make 
an evasive maneuver to avoid a collision. Such surrogate measures have been shown to correlate 
to some degree with the historical frequency of crashes at intersections. This technique may be of 
use to researchers, transportation engineers, construction and design companies, and safety 
engineers.  
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SI* (MODERN METRIC) CONVERSION FACTORS 
APPROXIMATE CONVERSIONS TO SI UNITS

Symbol When You Know Multiply By To Find Symbol 
LENGTH 

in inches 25.4 millimeters mm 
ft feet 0.305 meters m 
yd yards 0.914 meters m 
mi miles 1.61 kilometers km 

AREA 
in2 square inches 645.2 square millimeters mm2

ft2 square feet 0.093 square meters m2

yd2 square yard 0.836 square meters m2

ac acres 0.405 hectares ha 
mi2 square miles 2.59 square kilometers km2

VOLUME 
fl oz fluid ounces 29.57 milliliters mL 
gal gallons 3.785 liters L 
ft3 cubic feet 0.028 cubic meters m3 

yd3 cubic yards 0.765 cubic meters m3 

NOTE: volumes greater than 1000 L shall be shown in m3

MASS 
oz ounces 28.35 grams g
lb pounds 0.454 kilograms kg
T short tons (2000 lb) 0.907 megagrams (or "metric ton") Mg (or "t") 

TEMPERATURE (exact degrees) 
oF Fahrenheit 5 (F-32)/9 Celsius oC 

or (F-32)/1.8 
ILLUMINATION 

fc foot-candles 10.76 lux lx 
fl foot-Lamberts 3.426 candela/m2 cd/m2

FORCE and PRESSURE or STRESS 
lbf poundforce   4.45    newtons N 
lbf/in2 poundforce per square inch 6.89 kilopascals kPa 

APPROXIMATE CONVERSIONS FROM SI UNITS 
Symbol When You Know Multiply By To Find Symbol 

LENGTH
mm millimeters 0.039 inches in 
m meters 3.28 feet ft 
m meters 1.09 yards yd 
km kilometers 0.621 miles mi 

AREA 
mm2 square millimeters 0.0016 square inches in2 

m2 square meters 10.764 square feet ft2 

m2 square meters 1.195 square yards yd2 

ha hectares 2.47 acres ac 
km2 square kilometers 0.386 square miles mi2 

VOLUME 
mL milliliters 0.034 fluid ounces fl oz 
L liters 0.264 gallons gal 
m3 cubic meters 35.314 cubic feet ft3 

m3 cubic meters 1.307 cubic yards yd3 

MASS 
g grams 0.035 ounces oz
kg kilograms 2.202 pounds lb
Mg (or "t") megagrams (or "metric ton") 1.103 short tons (2000 lb) T 

TEMPERATURE (exact degrees) 
oC Celsius 1.8C+32 Fahrenheit oF 

ILLUMINATION 
lx  lux 0.0929 foot-candles fc 
cd/m2 candela/m2 0.2919 foot-Lamberts fl

FORCE and PRESSURE or STRESS 
N newtons 0.225 poundforce lbf 
kPa kilopascals 0.145 poundforce per square inch lbf/in2

*SI is the symbol for th  International System of Units.  Appropriate rounding should be made to comply with Section 4 of ASTM E380.  e
(Revised March 2003)  
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INTRODUCTION 
 
The Surrogate Safety Assessment Model (SSAM) is a software application designed to 
perform statistical analysis of vehicle trajectory data output from microscopic traffic 
simulation models. The software computes a number of surrogate measures of safety for 
each conflict that is identified in the trajectory data and then computes summaries (mean, 
max, etc.) of each surrogate measure. This document explains the installation, 
configuration, and usage of the SSAM software, focusing primarily on the graphical user 
interface features. This chapter summarizes the organization of the document. 

ORGANIZATION OF THE USER MANUAL 

This document explains terms and definitions pertinent to the installation and operation 
of the SSAM software. The major chapters of the user manual are outlined as follows and 
are in chronological order. 
 
Chapter 1. Installation  

This section describes how to install the SSAM software using the automated SSAM 
installation program, SSAMinstall.exe. The section also describes how to uninstall the 
SSAM software. 
 
Chapter 2. Graphical User Interface  

This section describes how to use the graphical user interface of SSAM to perform 
conflict analysis on simulation trajectory data files. The Analysis section walks through 
an example to demonstrate the configuration and the usage of the available views and 
filters to analyze the simulation data. The Usability section reviews the Help menu, the 
different viewing options available in the SSAM software, and the functionality provided 
by the tool to export data from a SSAM case document to a .csv file, which can be 
viewed in Microsoft® Excel. The Error Checking section provides a description of some 
of the error checking performed on user input.  
 
Appendix. Terms and Definitions 

This section explains the terms and measures necessary to interpret the data viewed on 
the SSAM software screens. 
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CHAPTER 1. INSTALLATION 
 
INSTALLING SSAM 

The SSAM software may be installed using an available installation program, 
SSAMinstall.exe. This InstallShield™ icon is shown in figure 1. 
 

 
Figure 1. Screen Capture. Installation Program, SSAMinstall.exe. 

 
Double-click SSAMinstall.exe to bring up the InstallShield™ Wizard screen as seen in 
figure 2. At this point, the installer initializes itself and looks for a Java Virtual Machine 
(JVM) on the local machine. If a JVM is not found on the local machine, the installer will 
install the appropriate JVM. The SSAM software has been developed and tested for 
Windows XP; however, it was built with Java technology and other platforms may be 
supported in the future. 
 
 

 
Figure 2. Screen Capture. InstallShield Wizard Screen. 

 
Once the installer initializes and installs the JVM on the local machine, it brings up the 
Welcome screen as shown in figure 3. Click Next to continue installation of the SSAM 
software. 
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Figure 3. Screen Capture.  Installer Screen—InstallShield Welcome Screen. 

 
Click Next to bring up the screen shown in figure 4. 
 

 
Figure 4. Screen Capture. Installer Screen—Directory Name. 
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As seen in figure 4, the installer will install the SSAM.exe file in the 
C:\ProgramsFiles\FHWA\SSAM directory by default. The user can choose to install the 
SSAM software in a different path by clicking Browse. Click Next to bring up the 
window seen in figure 5. 
 

 
Figure 5. Screen Capture. Installer Screen—Option Choices Typical or Custom. 

 
As seen in figure 5, the installer gives the user the option of either a typical or a custom 
install. In a typical install, the user does not have the option of selecting software features 
to be installed. In the case of SSAM, all the functionality is bundled into a single feature. 
As a result, choosing the custom installation is not necessary. Figure 6 shows the screen 
when the user selects the typical install option and figure 7 shows the screen when the 
user selects the custom install option. 
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Figure 6. Screen Capture. Installer Screen—Typical Installation Option. 

 

 
Figure 7. Screen Capture. Installer Screen—Custom Installation Option. 
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Click Next to proceed with the installation of the SSAM software. The installer will 
install the SSAM software on the local machine. Figure 8 shows the screen displayed as 
the installation process is being carried out. 
 

 
Figure 8. Screen Capture. Installer Screen—Installation Process. 

 
Figure 9 shows the screen displayed when the installation is successful.  
 

 
Figure 9. Screen Capture. Installer Screen—Installation Complete. 
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Click Finish to complete the installation of the SSAM software. A shortcut to the 
SSAM.exe file is created in the Programs menu. Figure 10 shows where the SSAM 
launcher and the SSAM uninstaller are installed. There is no need for the user to reboot 
the computer to begin using SSAM. 
 

 
Figure 10. Screen Capture. Location of Installed SSAM Launcher and SSAM 

Uninstaller. 
 
UNINSTALLING SSAM  

To uninstall the SSAM software, click on SSAM Uninstall in the Programs menu as 
seen in figure 10. The uninstaller will begin to initialize and bring up the screen shown in 
figure 11.  
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Figure 11. Screen Capture. Uninstaller Screen—InstallShield Welcome Screen. 

 
As seen in figure 12, the installer informs the user that the SSAM software will be 
uninstalled from the local machine. Click Next to bring up the screen shown in figure 13. 
 

 
Figure 12. Screen Capture. Uninstaller Screen—Product Uninstallation Features. 
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As mentioned previously, all the functionality of the SSAM software is bundled in one 
feature. Uninstalling SSAM implies that the Full SSAM application must be uninstalled. 
Figure 12 shows that the uninstaller will remove this installed feature from the local 
machine. Click Next to bring up the screen shown in figure 13. 
 

 
Figure 13. Screen Capture. Uninstaller Screen—Uninstalling from Local Machine. 

 
This screen informs the user that the SSAM software is about to be uninstalled from the 
local machine. Click Next to instantaneously uninstall the SSAM software from the 
machine and bring up a screen that tells the user that the uninstall process is complete. 
This screen is shown in figure 14. 
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Figure 14. Screen Capture. Uninstaller Screen—Uninstall Process Complete. 

 
Click Finish to complete the process. None of the SSAM options will appear in the 
Programs menu after the uninstall process is complete. 
 
LAUNCHING THE SSAM SOFTWARE 

Click the SSAM icon shown in figure 10 to start the SSAM software. Figure 15 shows 
the screen when SSAM is started for the first time after installation.  
 

 
Figure 15. Screen Capture. SSAM—Beginning Screen. 





 

CHAPTER 2. GRAPHICAL USER INTERFACE 
 
This section of the user manual is divided into the following subsections: 
 
1. INTRODUCTION  

This subsection provides a general description of the menus, menu items, toolbars, and 
screens available in SSAM. 
  
2 .CONFIGURATION 

This subsection describes how to use the configuration screen so that SSAM can process 
the required data files to extract information based on user-defined parameters.  
 
3. ANALYSIS  

This subsection gives an overview of the conflict and summary screens. It also describes 
how the filter provided by SSAM can be used to view all or some of the processed data in 
the conflict and summary screens.  
 
4. USABILITY 

This subsection explains how multiple files can be saved and viewed using the menus and 
menu items provided by SSAM. This section also describes how the software can be used 
to export data from a case document to a .csv file viewable in Microsoft® Excel. 
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INTRODUCTION 

Figure 16 is a screen shot of the SSAM software when it is started for the first time after 
installation. 
 

 
Figure 16. Screen Capture. SSAM Screen—Beginning Screen with Callouts. 

 
As seen in figure 16, the graphical user interface can be divided into the following four 
main parts:  
 
1. Case document viewer  

This part of the screen is used to view the data related to the selected case document or 
trajectory file.  
 
A case document is selected by double-clicking on the case document in the case 
document viewer.  
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2. Menus 

This part of the tool is used to save, open, view, and export case documents. It also 
contains the Help menu. 
  
3. The toolbar area  

This part contains buttons to save, open, view, and export case documents. 
 
4. The internal frame  

This part contains six tabs. These tabs will be viewable in the internal frame when a case 
document is created. The available tabs are summarized as follows: 

• Configuration screen: This screen is used to load data files to be analyzed. It 
provides the user with the ability to save information about the analysis, such as 
the name and description. The configuration screen also allows the user to set 
certain threshold values based on which tool will process the data in the selected 
.trj files. The Configuration tab is selected by default. 
 

• Conflict screen: To view this screen, click the Conflict tab. The screen contains a 
view of the conflict data extracted from the .trj files in a table shown in a 
scrollable window. Details of what the data in each column and row represent are 
defined in the Terms and Definitions section of this document. 
 

• Summary screen: Click the Summary tab to bring up the Summary table view 
which provides a statistical summary of the data viewed in the Conflict tab. The 
details of what each column and row represent are defined later in this manual.  
 

• Filter screen: Click the Filter tab to bring up a screen which can be used to filter 
data viewed in the Conflict and Summary tabs. Parameters for viewing include 
threshold values, location, and types of conflicts. Details on use of the filter 
screen buttons are described later in this manual.  
 

• T-test screen: Click the T-test tab to bring up a screen that enables the user to 
perform t-test analysis between the selected case file and a newly added case file. 
This screen allows the user to export the t statistics results about the analysis. 
Details on use of the t-test screen are described later in this manual.  
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• Map screen: The current version of the SSAM software does not include the map 
feature. The Map tab does not contain any functionality or data at this time.  

 
Figure 17 labels the buttons available in the toolbar section. 
 

 
Figure 17. Screen Capture. SSAM Screen—Toolbar Section Buttons. 

 
As seen in figure 17, the toolbar section of the tool includes the following buttons: 

• New: Click to create a new case document. 

• Open: Click to open an existing case document. 

• Save: Click to save the case document. 

• Toggle: Click to display or hide the left-hand side case document view. 

• Horizontal tile: Click to tile the case documents in the internal frame horizontally. 

• Vertical tile: Click to tile the case documents vertically in the internal frame. 

• Grid tile: Click to organize the case documents in the internal frame in a gird. 

• Cascade tile: Click to see a cascade view of the case documents. 

• Export: Click to export the case document’s conflict data to a .csv file. 
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Figure 18 and figure 19 show options available through the File menu and Window 
menu, respectively. 

 

 
Figure 18. Screen Capture. SSAM Screen—File Menu. 

 

 
Figure 19. Screen Capture. SSAM Screen—Window Menu. 
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CONFIGURATION 

If SSAM was used previously to perform analysis and the data was saved, a list of the 
saved case documents will display in the case document viewer. 
 
Creating a New Case Document 

This section walks through the steps of creating a new SSAM case document. This 
presentation assumes that SSAM has been started for the first time and does not contain a 
list of case documents in the case document viewer. To create a new SSAM case 
document, point to New in the File menu or click New in the toolbar. This will bring up 
the file selection window where the user can type in the desired file/case name. Figure 20 
shows the user interface after creating a new case document. 
 

 
Figure 20. Screen Capture. SSAM Screen—Configuration Tab. 

 
The case document 7692 yale road & hocking avenue_ssam appears in the case 
document viewer. The Configuration tab is selected by default in the internal frame. 
 
As seen in figure 20, the Configuration tab displays the following information: 
 

• Case Information 
Case File: This is the name of the case file including the full path of the file. 
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Comments: This information can be edited by the user to save certain comments 
associated with the case document. 

Analyst: The name of the user analyzing the data can be entered in this field. 

Analysis Date: This field is updated automatically when the document is saved. 

• Case Files 
This section is used to load .trj files, which serve as input to the analysis process. 

• Conflict Thresholds 

This section allows the user to set the Times to Collision (TTC) and Post 
Encroachment Time (PET) threshold values for the analysis process. For example, if 
the user sets the Maximum TTC value to 1.5, then the analysis will only yield conflict 
data that contains TTC values less than 1.5. 

 

 
Figure 21. Screen capture. SSAM Screen—Configuration Tab Displaying Case 

Information.  
 
Click Edit Info to change the case information. This will allow the text areas in the case 
file section to be edited and activate the apply change button. For example, figure 21 
displays the following information:  
 

• Comments: This is an example. 

• Analyst: User. 
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To apply the change to the case information section, click Apply Change. This activates 
the Edit button and disables the text boxes as shown in figure 20. Note that this is not the 
same as saving the case document. The Apply Change button simply applies the changes 
to the Configuration tab of the internal frame so that case information exists on the 
screen even if the user switches tabs. 
 
Adding Trajectory Files to a Case Document 

Users can also select trajectory files that need to be analyzed. Click Edit to enable the 
case files in the threshold section of the Configuration tab. Figure 22 shows these fields 
activated. 
 

 
Figure 22. Screen Capture. SSAM Screen—Configuration Tab Displaying Case Files. 

 
Clicking Edit enables the user to click Apply while the Edit and Analyze buttons are 
disabled. To add a trajectory file to the case document, click Add. This will bring up a 
file selection menu through which single or multiple files can be selected.  
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Figure 23. Screen Capture. SSAM Screen—Configuration Tab Displaying Case Files: 

File Selection. 
 
Figure 23 shows the file selection screen with multiple case files selected.  
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Figure 24. Screen Capture. SSAM Screen—Configuration Tab Displaying Case Files: 

Files Added. 
 
Figure 24 shows five files added to the case files section. Note that the files selected have 
a .trj extension. In this example, default maximum TTC and maximum PET values in the 
Conflict Thresholds section are not changed.  
 
Once the user has selected the case documents, changes can be applied to the case 
document. The user can click Edit again to add or delete any of the trajectory files in the 
case files section. Just as multiple files can be added, multiple files can be selected and 
deleted by clicking Delete in the case files section. Click Apply to activate the Edit and 
Analyze buttons as shown in figure 25. 
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Figure 25. Screen Capture. SSAM Screen—Configuration Tab Displaying Case Files: 

Selection Applied. 
 
Processing Trajectory Files 

Click Analyze to start the analysis process. The SSAM software starts processing the 
data from each trajectory file to extract conflict data information from these files. The 
processing of trajectory files can take a long time depending on the size of each file and 
the number of trajectory files that need to be analyzed. The SSAM software presents the 
user with progress information about the processing of the trajectory files as shown in 
figure 26.  
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Figure 26. Screen Capture. SSAM Screen—Configuration Tab Displaying Case Files: 

Analysis Progress. 
 
Clicking Analyze displays a window which shows progress information. In figure 26, 
7 percent of the first file is complete and 1 percent of the total processing is done. This 
screen prevents the user from selecting any other options except Cancel. The screen 
provides the user with an option of canceling the entire analysis request. After the 
processing is complete, a message informs the user that the analysis process is finished 
without any errors. This can be seen in figure 27. 
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Figure 27. Screen Capture. SSAM Screen—Configuration Tab Displaying Case Files: 

Analysis Complete. 
  
This message means that relevant conflict data can now be viewed in the Conflict tab of 
the internal frame. Internally, once the processing of the files is finished, the tool 
immediately starts calculating summaries, which can be viewed in the Summary tab of 
the internal frame. The software then informs the user that the summaries have been 
calculated, as seen in figure 28. 
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Figure 28. Screen Capture. SSAM Screen—Configuration Tab Displaying Case Files: 

Summary Complete.  
 
The user is now ready to analyze the conflict and summary data obtained from the 
trajectory files. The next section of this manual covers the Conflict, Summary, and 
Filter tabs of the internal frame which help the user analyze the output conflict data 
populated by the SSAM software.  
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ANALYSIS 

The analysis portion of the SSAM software allows users to filter conflicts, graphically 
visualize the conflicts within VISSIM .inp files, export maps, and perform t-tests between 
alternative case studies.  
 
Note on Units of Analysis 

SSAM does not allow user selection of the units of display and will perform no 
conversions (e.g., from metric to English or vice-versa). All values are interpreted and 
displayed in the units specified in the .trj files processed by SSAM. Some simulation 
vendors allow users to specify the units used in their simulation as metric or English; 
however, note that the units specified in the simulation may or may not affect the 
trajectory file output.1 
 
Using the Conflict Tab 

Figure 29 shows the Conflict tab after the tool is done analyzing the trajectory files.  
Notice that the first row of the conflict tab displays, “NO FILTER APPLIED.” This 
means that the data shown is a complete result set obtained from processing trajectory 
files. 
 

                                                 
 

    1 Some issues with proper specification of units have been noted in certain versions of VISSIM (version 4 series), in 
which case use of metric units is suggested with version 4 to avoid potential issues.   
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Figure 29. Screen Capture. SSAM Screen—Conflict Tab. 

 
The Conflict tab displays a table in which each row represents a conflict and each 
column represents certain information about that conflict. There are a total of 40 
columns. As seen in figure 29, the Conflict tab provides a scrollable view of the conflict 
data. The size of each column can be adjusted. View the Terms and Definitions section of 
this document for a description of each column in the conflict table. Users can sort data 
by column in the Conflict tab by clicking the column header.  
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Using the Summary Tab 

Figure 30 shows the Summary tab after the tool has analyzed the trajectory files. Notice 
that the first row of the Summary tab displays, “NO FILTER APPLIED.”  
 

  
Figure 30. Screen capture. SSAM Screen—Summary Tab. 

 
The data shown is a summary of the unfiltered conflict data in the Conflict tab. The 
Summary tab contains two tables. The first table provides a statistical summary of 
conflict data magnitudes, while the second table provides a summary of the total number 
of conflicts and the total number of conflict for each type seen in the Conflict tab. The 
first table provides statistical data on the following SSAM measures, which are defined in 
the appendix: 
 

• TTC. 

• PET.  

• MaxS.  

• MaxD (Maximum deceleration).  

• DeltaS (Speed difference).  

• DR.  
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• MaxDeltaV.  

The statistical data is provided in terms of the minimum, maximum, mean, and variance 
of each of the above stated SSAM measures. 
 
The second table provides a summary of the total number of conflicts broken down by 
type of conflicts. The four types of conflicts are 
 

• Unclassified. 

• Crossing. 

• Rear-end. 

• Lane-change. 

 
The logic to classify conflicts into these types is summarized as follows: 
 
A conflict angle is calculated for each pair of conflicting vehicles, based on the angle at 
which these vehicles converge to a hypothetical collision point. See the definition of 
clock angle in the appendix for more detailed definition. Very small (acute) angles 
indicate that the vehicles were on nearly the same trajectory (e.g., a rear-end event might 
have a conflict angle of 0 °), whereas large angles (plus or minus 180 ° being the largest) 
indicate that the two vehicle were on a head-on course. An angle of plus or minus 90 ° 
indicates two vehicles on perpendicular paths. The angle is expressed from the 
perspective of the first car to arrive at the collision point. Positive angles indicate the 
second vehicle is approaching from the right, and negative angles indicate the second 
vehicle is approaching from the left. Thus, the range of angles is from negative 180 ° to 
positive 180 °. 
 
Conflicts classification is generally based on the conflict angle, although link and lane 
information may affect the classification. For example, if two vehicles have a conflict on 
the same link and lane, then the conflict is a rear-end event regardless of the conflict 
angle. If both vehicles are on the same link and one of the vehicles changes lanes, then it 
is a lane-change event regardless of the conflict angle. However, link and lane 
information is not used if (a) it is not provided in the trajectory file, (b) the vehicles are 
on differing links, or (c) either vehicle changed links over the course of the conflict event. 
In such cases, the conflict angle is used for classification as follows: 
 

• Unclassified: Conflict angle unknown. 

• Crossing: || conflict angle || > 85 °. 

• Rear-end: || conflict angle || < 30 °. 

• Lane-change: 30 ° ≤ || conflict angle || ≤ 85 °. 
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The threshold angles (30 ° and 85 °) were determined by limited experimentation, though 
there are cases where classification is difficult. One such case involves a vehicle traveling 
in a traffic circle (within a roundabout) which crashes/conflicts with a vehicle entering 
the roundabout. Determining the appropriate type can be subjective if only one type can 
be selected. It is possible that these angle-thresholds will be exposed for user 
configuration in a future version of SSAM. 
 
Notice that in figure 30 both tables provide a combined summary for all trajectory files as well 
as a break down of summaries by each trajectory file. These summaries are circled in figure 
30. Unlike in the Conflict tab, data in the Summary tab cannot be sorted. The columns in the 
Summary tab can be resized and positioned differently. 
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Using the Filter Tab 

  
Figure 30Figure 31 shows the Filter tab of the internal frame with default settings. Large 
amounts of data in the Conflict tab can make finding conflicts which have certain 
commonalities or follow a certain pattern difficult for the user. The Filter tab allows the 
user to filter the data in the Conflict tab using the five criteria shown in figure 31. 

 

 
Figure 31. Screen Capture. SSAM Screen—Filter Tab with Default Settings.  

 
• Surrogate Thresholds  
 The user can specify a range of allowable values for each of several surrogate 

measures (e.g., TTC and PET) to filter out conflicts that do not fall in the specified 
ranges.    

• Conflict Types 

 The user can view conflicts by the type of conflict. The user can also select multiple 
conflicts in this list. The default filter is ALL, which means the user can view all types 
of conflicts. 
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• Link Types 
    The user can filter conflicts by link number. The link list in the Filter tab is a 

scrollable list of all the links by which one can filter the conflict data. The default 
filter is ALL in this list. The user can select multiple links, 

• Trj Files 

 The user can filter conflicts by .trj files. All the .trj files that have been analyzed in 
the case documents are listed. The default filter is ALL, which means that the 
conflicts viewed by the user are extracted from all of the .trj files. The user can 
view conflicts extracted from any single or combination of .trj files by filtering in 
this area.  

• Location Filter 
 Each trajectory file is loaded along with coordinate information which defines the area 

within which the conflicts occur. The user can view conflicts in a given part of the 
map by defining this area by specifying the x and y coordinates of the lower-left and 
upper-right points of a rectangular region.  

 

 
Figure 32. Screen capture. SSAM Screen—Filter Tab with Filter Settings. 
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Figure 32 displays the filter settings shown when the user chooses to view all the 
conflicts with 
 

• A TTC value within the range of 0 and 2.75 seconds. 

• A PET value within the range of 0 and 2.1 seconds. 

• All the lane change and rear end conflicts. 

• The rest of the filter settings are not changed. 

 
Applying the Filter 

Click the Apply button to calculate the filters and update the Conflict tab and the 
Summary tab. The tool informs the user that the filter was successfully applied, shown in 
figure 33. 
 

 
Figure 33. Screen Capture. SSAM Screen—Filter Tab with Filters Applied: 

Confirmation Message. 
 
The Restore Defaults button restores the filter settings to all the default settings. It also 
restores the content in the Conflict tab and the Summary tab to show all conflicts and 
summaries for those conflicts. Figure 34 shows the Conflict tab after the filter is applied. 
Notice that the first line in the window now displays, “FILTER APPLIED.” 
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Figure 34. Screen Capture. SSAM Screen—Conflicts Tab: Filtered Conflicts Table. 

 
Figure 35 shows the Summary tab after the filter is applied. Notice that the first line in 
the window now displays, “FILTER APLIED.” 
 

 
Figure 35. Screen Capture. SSAM Screen—Summary Tab: Filtered Summary Tables. 
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The summary tables now show the following kinds of summaries in chronological order: 
 

• Unfiltered All Files 
This category is the summary for all the conflicts. 
 

• Filtered All Files 

This category is the summary for all the conflicts which are now filtered into the 
Conflict tab. 
 

• Filtered File 
This category is the summary for the filtered conflicts in the corresponding file.  
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Using the T-Test Tab 

Figure 36 shows the t-test tab of the internal frame. 
 

 
Figure 36. Screen Capture. SSAM Screen—Ttest Tab.  

  
There are three sections in the ttest tab: 
  

• SSAM Files  

 This section is used to load additional case files for t-test analysis.  

• Ttest configuration 
 This section allows the user to set the significant levels for the t-test and f test. The 

user also selects the data set to be analyzed in this section.  

• T-test results section 
 Before an analysis has been performed, this section displays t-test has not been 

applied. The display will change to t-test has been applied when the user clicks 
Analyze. The tabular results of the analysis will also be displayed.  

Adding Another Case Document  

Users can select additional case documents to be compared with the current case 
document. Click the Edit to enable the SSAM files and t-test configuration sections of 
the t-test tab as shown in figure 37. Notice once Edit has been clicked, the Apply button 
is activated and the Edit, Analyze, and Export buttons are disabled.  
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Figure 37. Screen Capture. SSAM Screen—Ttest Tab SSAM Files. 

 
To add a new case document file, click Compare opened file with in the SSAM files 
section. This will bring up a file selection menu through which single files can be 
selected. Figure 38 shows the file selection window. Once the file is selected, it can be 
seen in the SSAM files section of the ttest tab.  
 

 
Figure 38. Screen Capture. SSAM Screen—Ttest Tab File Selection Window. 

 
Figure 39 shows the case document file added to the SSAM file section, which is named 
152& 56_ssam in this example. The user can click Delete to delete the added case 
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document file or Compare opened file with to add another case document file. Since a 
t-test is used to compare the results of two case document files, only one other case 
document file can be added to the current case document for each analysis.  
 
After another case document file is added, three sets of data must be configured in the 
t-test configuration section shown in figure 39 before the t-test analysis can begin.  
 
The data to be configured include the following: 
 

• T-test Significant Level 
 This value is used in the t-test analysis to reflect the t statistic significant level.  

 
• F test Significant Level 
 This value is used in the t-test analysis to reflect the f statistic significant level, which 

is used to determine the sample variances significance.  
 

• Data set to be analyzed 

 There are two options available for the data set to be analyzed: All Data and Filtered 
Data. The user can perform the t-test on the unfiltered data of these two case 
documents by selecting All Data. Select Filtered Data for the t-test results on the 
filtered data of these two case documents.  

 

 
Figure 39. Screen Capture. SSAM Screen—Ttest Tab Default Settings. 
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As seen in figure 40, the t-test configuration section displays the following settings: 
 

• 0.05 for t-test significance level. 

• 0.1 for f test significance level. 

• Unfiltered data for both case documents.  

 

 
Figure 40. Screen Capture. SSAM Screen—Ttest Tab Modified Settings. 

 
After both the SSAM file section and t-test configuration sections have been configured, 
click Apply. The added case document opens and becomes the active window.  
At the same time, a message informs the user that the second case document is now open, 
as shown in figure 41.  
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Figure 41. Screen Capture. SSAM Screen—Ttest Tab Open Confirmation Message. 

 
With the second case document open, the user can perform all necessary changes. To 
confirm changes, click OK. This reactivates the previous case document window, as 
shown in figure 42. 
 

 
Figure 42. Screen Capture. SSAM Screen—Ttest Tab Active Case Document. 

 
This is all the necessary data for the t-test analysis, which will compare the unfiltered 
conflicts data for these two case documents with t-test significant level 0.05 and f test 
significant level 0.1. By clicking Analyze, the tabular t-test results will be displayed in 
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the result section, as shown in figure 43. The label has been changed to t-test for all data 
that have been applied. 
 
 

 
Figure 43. Screen Capture. SSAM Screen—Ttest Tab Results Table. 

 
The t-test results table has two subtables. Figure 44 provides a clear view of the table, 
which includes the following sections: 
 

• Surrogate measure t-test results 
 This table displays the t-test results for all safety surrogate measures analyzed by 

SSAM, including TTC, PET, MaxS, DeltaS, DR, DeltaD, and MaxDeltaV.  

• Conflict numbers t-test results 
 This table displays the t-test results for conflict numbers analyzed by SSAM, including 

total conflicts, crossing conflicts, rear-end conflicts, and lane-changing conflicts. 

 

 
Figure 44. Screen Capture. SSAM Screen—Ttest Tab with Enlarged Results Table. 
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For each subtable, there are 11 columns. The first column lists the SSAM measures to be 
analyzed. For each measure, columns 2 through 4 list the corresponding mean, variance, 
and number of samples for the first case document. In this example, that document is 
7692 yale road & hocking avenue_ssam. Columns 5 through 7 list the mean, variance, 
and number of samples for the second case document. In this example, that document is 
152& 56_ssam. Column 8 shows the t value calculated for each measure. Column 9 
displays the t critical value, obtained by looking at t tables. Column 10 shows whether or 
not each type of measure between these two case documents is significantly different. 
Column 11 shows the relative difference between the mean values of each measure.  
 
Exporting the T-Test Results 

The t-test results can be exported to a .csv file. Click Export to bring up the file menu 
shown in figure 45. By default, the exported file given the same name as the case 
document; in this example, the file is named 7692-yale road & hocking 
avenue_ssam_t-test.csv. Click Save to save the file.  
 

 
Figure 45. Screen Capture. SSAM Screen—Ttest Tab Export T-Test Results. 

 
Figure 46 shows the 7692-yale road & hocking avenue_ssam_t-test.csv file open in 
Microsoft® Excel. The first row of the .csv file displays the column names as seen in the 
results table of the case document. 
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Figure 46. Screen Capture. Excel Screen—T-Test Results in .csv File. 
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Viewing the T-Test Analysis on Filtered Data 

 
Figure 47. Screen Capture. SSAM Screen—Ttest Tab Filtered Data Selected. 

 
Figure 47 displays the performance of the t-test on filtered data for those two case 
documents. When the user clicks Apply, a message appears to confirm the change as 
shown in figure 48.  
 

 
Figure 48. Screen Capture. SSAM Screen—Ttest Tab Filtering Confirmation Message. 
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After clicking OK, the user can click Analyze to continue the t-test process or return to 
the filtering screen for each case document to perform the desired filtering before 
continuing. If both case documents have filtered data, clicking Analyze will result in a 
t-test results table similar to figure 43. If one of the case documents does not have filtered 
data, a warning message will appear as shown in figure 49. This message displays, 
“There’s no filtering data for one or two of the case files.” The user must to go back to 
check on those two case files.  
 

 
Figure 49. Screen Capture. SSAM Screen—Ttest Tab Analyze Warning Message. 
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Using the Map Tab  

SSAM contains a built-in feature to visualize conflicts with respect to type (crossing, 
rear-end, or lane changing) and a time-to-collision preset threshold. The conflicts can be 
visualized within a map or imported to SSAM as a graphical image (20+ formats 
supported) or VISSIM .inp file. Visualization through an .inp file is more user-friendly 
because, unlike in the graphical image, map coordinates are specified. 
 
Figure 50 shows the Map tab for a case document.  
 

 
Figure 50. Screen Capture. SSAM Screen—Map Tab. 

 
There are two sections in the Map tab—the Map Info and the Map View—which are 
described in the following subsections: 
 
Map Info 

This section allows the user to load the map file or VISSIM .inp file and to configure the 
conflicts that will be displayed within the map. It has four subsections, shown in figure 
51. 

• Map: This section allows the user to load the map file or VISSIM .inp file for the case 
document. Typically, the map file is the graphic file of the simulated network for the case 
document. The user must provide the location of the file and the coordinates for the upper-
left and lower-right corners of the map image. For more information on retrieving 
coordinates from a simulated network is in the Recoding Map Coordinates section of this 
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manual. The VISSIM .inp file is the VISSIM network file that has been simulated and has 
generated the vehicle trajectory file that was used for SSAM analysis.  

• Conflicts type display configurations: This section allows the user to configure the icon 
shape for displaying different type of conflicts.  

• Conflicts color configurations: This section allows the user to configure the color for 
displaying conflicts with different severity levels.  

• Conflicts: This section allows the user to enable the conflicts display in the map and 
export whole images.  

 

 
Figure 51. Screen Capture. SSAM Screen—Map Tab Map Info Section. 

 
Map View 

This section of the user interface, outlined in red in figure 52, is used to display the 
loaded map and to show the conflicts configured and filtered by the user within the map. 
Before the map is loaded, this section is empty.  
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Figure 52. Screen Capture. SSAM Screen—Map Tab Map View Section. 

 
Showing Conflicts Without Loading Map Files 

SSAM can show conflicts in the map view section without loading a map file as a 
background. This is done by clicking Show at the bottom of the Map Info section. Figure 
53 shows the display of 318 conflicts in the map view section. No map file or map 
coordinates have been specified. Conflicts shown without loading a map file are only a 
view of conflict layout. To receive detailed conflict information (e.g., absolute location), 
the user must load the corresponding map file and specify the correct map coordinates, 
which is covered in the next section of the manual.  
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Figure 53. Screen Capture. SSAM Screen—Map Tab Conflicts Without Background. 

 
The conflicts shown in the map view section are in sync with the conflicts specified by 
the filter panel. Figure 54 shows the filtered conflicts. 
 

 
Figure 54. Screen Capture. SSAM Screen—Map Tab Filtered Conflicts Without 

Background. 
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Showing Conflicts on Loaded Map Image  

Users can load a map file to be used as a background displaying the conflicts within the 
current case document. Click the Edit map button which corresponds to the map label in 
the Map Info section to bring up a file selection menu. A single file can be selected from 
this menu. Figure 55 shows the file selection window with the label Import map image. 
   

 
Figure 55. Screen Capture. SSAM Screen—Map Tab Import Map Image. 

 
Once the map image file is selected, it can be seen in the map view section of the Map 
tab, as shown in figure 56. In this example, the selected map image file is named 
yale&hocking.bmp. The description label in the first row of the Map Info section has 
changed to yale&hocking.bmp, denoting that a map image file named has been loaded 
into the case document successfully.  
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Figure 56. Screen Capture. SSAM Screen—Map Tab with Map File Loaded. 

 
The software will use the loaded map image as a background to show the analyzed 
conflicts. To locate those conflicts, the user must specify the (x, y) coordinates of the 
reference points within the map image. The user can specify (x, y) coordinates for two 
reference points: the upper-left and lower-right corners of the map image. To specify the 
coordinates, click Edit in the Coord section. This will result in the message shown in 
figure 57, which states, “Please provide the coordinates (x1, y1) and (x2, y2) for the upper-
left and lower-right corners of the map image.” Type all (integer or decimal) values on 
one line, separated by a single space.  
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Figure 57. Screen Capture. SSAM Screen—Map Tab Map Coordinates Input. 

 
Figure 58 shows four entered data points (separated by space). Click OK to continue. 
 

 
Figure 58. Screen Capture. SSAM Screen—Map Tab Map Coordinates Input Entered. 

 
Figure 59 shows the input values recorded as two (x, y) coordinates. These coordinates 
replace the description label None Specified in the second row of the Map Info section. 
As shown in figure 59, conflicts are located within the intersection shown on the map 
image and the conflicts layout matches the intersection geometry. Each conflict dot 
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represents a single conflict or multiple conflicts happening in the same place. Click each 
conflict dot to retrieve a display of the detailed information for the conflicts. The green 
rectangle surrounding all of the conflicts represents the conflicts location range specified 
by the Location Filter in the Filter tab. 
 

 
Figure 59. Screen Capture. SSAM Screen—Map Tab Conflicts with Background. 

 
Users can zoom in or out of the map view by clicking + or - in the Coord section. Figure 
60 shows a zoomed in view of the conflicts and the map image. Click Fit to restore the 
default map view.  
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Figure 60. Screen Capture. SSAM Screen—Map Tab with Zoomed Map View. 

 
Conflicts shown here are in sync with the conflicts specified by the conflicts table and 
summary table in the Filter tab. To only view conflicts with specified filtering criteria, 
users can perform the preferred filter operations in the Filter tab and then return to the 
Map panel. Filtered conflicts are shown in the map panel. Figure 61 shows only lane 
change conflicts with 1.0 = < TTC < = 1.5. 
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Figure 61. Screen Capture. SSAM Screen—Map Tab with Filtered Conflicts. 

 
Showing Conflicts on Loaded VISSIM .inp File  

Users can load a VISSIM .inp file to generate the corresponding .trj file processed by 
SSAM. Click Edit inp in the Map Info section to retrieve a file selection menu through 
which a single file can be selected. Figure 62 shows the file selection window. In this 
example, the file selected is yale&hocking.inp. Click Open to import the file.   
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Figure 62. Screen Capture. SSAM Screen—Map Tab Load .inp File. 

 
The Coord Edit button is inactive as the user will not provide the coordinates for the 
loaded .inp file. After loading the .inp file, the network displays in the map view section, 
as shown in figure 63.  
  

 
Figure 63. Screen Capture. SSAM Screen—Map Tab Loaded .inp File and Generated 

Network. 
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The loaded .inp file contains all the needed information for the network. Conflicts 
generated from this network are shown once the .inp file is loaded. A zoomed in view of 
the network is shown in figure 64. 
 

 
Figure 64. Screen Capture. SSAM Screen—Map Tab with Zoomed View of Generated 

Network. 

Saving Image File  

Users can export the image shown in the map view section by clicking Save image at the 
bottom of the Map Info section. As shown in figure 65, clicking Save image will retrieve 
a file selection window labeled Save Image. SSAM allows the image to be save in .png 
format only. In this example, the image is saved as 7692-yale & hocking 
avenuw_ssam.png. Figure 66 shows the resulting .png file displayed using Microsoft® 
Office Picture Manager. 
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Figure 65. Screen Capture. SSAM Screen—Map Tab Saving Image. 
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Figure 66. Screen Capture. Microsoft® Office Picture Manager—.png Format Image 

Open. 

Filtering Conflicts by Area 

In SSAM, the user can filter conflicts in the Filter tab and also filter conflicts by area in 
the Map tab. To filter in the Map tab, the user will drag a rectangle to specify the area of 
interest as shown in figure 67.  
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Figure 67. Screen Capture. SSAM Screen—Map Tab Specify Rectangle.  
 
A message will appear and ask the user to confirm, as shown in see figure 68. Click Yes 
to confirm the action.  
 

 

Figure 68. Screen Capture. SSAM Screen—Map Tab Filter Confirmation Message. 
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Only conflicts confined by the rectangle just specified will display. Figure 69 shows the 
resulting conflicts.  
 

 

Figure 69. Screen Capture. SSAM Screen—Map Tab Filtered Conflicts. 
 
Figure 70 shows that the values in the Location Filter in the Filter tab have changed to 
the values according to the dragged rectangle.  
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Figure 70. Screen Capture. SSAM Screen—Filter Tab Location Filter. 
 

Configuring Conflict Display  

After a map file is loaded into the case document, users can specify how different 
conflicts within the map file are displayed. As shown in figure 71, there are two types of 
settings to configure. The first part of configuration allows the user to choose the icon 
shape for different types of conflicts—crossing, rear-end, and lane-change. There are 
three icon shapes for each type of conflicts—oval, rectangular, and triangle. The second 
part of the configuration allows the user to select display colors for conflicts with 
different severity levels. Severity levels are classified according to different group of 
TTC values. They are crash conflicts with TTC less and equal to 0.5 second, conflicts 
with TTC less and equal to 1.0 second, and conflict with TTC less and equal to 
1.5 seconds.  
 
Figure 71 shows crossing conflicts with the oval icon, rear-end conflicts with the 
rectangular icon, and lane-change conflicts with the triangle icon. It also shows crashes in 
blue, conflicts with TTC < = 0.5 in red, conflict with TTC < = 1.0 in orange, and conflicts 
with TTC < = 1.5 in green. The user can enable the conflict display by clicking Show. 
Conflicts with the user-defined configurations will be shown in the map view window. 
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Figure 71. Screen Capture. SSAM Screen—Map Tab Conflicts Display Configuration. 

 
Figure 72 shows another conflict display with different color configurations.  
 

 
Figure 72. Screen Capture. SSAM Screen—Map Tab Additional Conflicts Display 

Configuration. 
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Displaying Conflict Line  

Users can receive detailed conflict information for each conflict point shown in the 
conflict map view, as shown in figure 73. There are two sections within the resulting 
window. The right section provides the detailed surrogate safety measures corresponding 
to this conflict, including TTC, PET, as well as vehicle IDs and lane/link IDs. The left 
section shows the conflict lines for the two vehicles involved in this conflict. A blue line 
represents the first vehicle and a red line represents the second vehicle. Both conflict 
lines have arrows to indicate movement direction.  
 
Sometimes clicking the conflict point will generate a set of windows because of multiple 
conflicts at this point. Up to 20 maximum windows can be generated by one click.  
 
 

 
Figure 73. Screen Capture. SSAM Screen—Map Tab Conflict Information Window. 

 
Recoding Map Coordinates 

Users can get the corner point coordinates of a .bmp file from a VISSIM (or others 
network. Figure 74 shows a VISSIM network file (.inp file) named 7692-yale road & 
hocking avenue.inp, which is the network that generates the .trj files used for the example 
in this manual.   
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Figure 74. Screen Capture. VISSIM Screen—Network Example. 

 
Map files can be generated by the print screen operation on this VISSIM network (or 
other programs). Users can paste in Print and save the image as .bmp file. The map 
corner coordinates can then be recorded within the VISSIM network, as shown in figure 
75 and figure 76. The user can move the mouse cursor to the upper-left corner and lower-
right corner of the network and record the coordinates data located at the bottom of the 
network in (x, y) format.  

66 



 

 
Figure 75. Screen Capture. VISSIM Screen—Record Upper-Left Corner Coordinates. 

 

 
Figure 76. Screen Capture. VISSIM Screen— Record Lower-Right Corner Coordinates. 
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Saving the Case Document 

To save the case document, click Save. Users can also choose Save in the File menu. In 
figure 77, the case document has not yet been saved, as indicated by the (unsaved) text 
appended to the case name in the title bar. In figure 78, the case document has been 
saved. 
  

 
Figure 77. Screen Capture. SSAM Screen—Case Document Not Saved. 
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Figure 78. Screen Capture. SSAM Screen—Case Document Saved. 
 
The case document can now be closed in the internal window. The case document 
remains in the workspace window after closing the case document as shown in figure 79. 
 

 
Figure 79. Screen Capture. SSAM Screen—Case Document Closed. 
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The case document can be opened again either by double-clicking on the case document 
name in the workspace window or by right-clicking on the case document name and 
choosing Open from the resulting menu. Choosing Delete from this menu will remove 
the document from the workspace and delete the case document from the disk.  
 
Editing an Existing Case Document 

To reopen a case document, double-click on the case file name in the case document 
workspace. The case document then appears in the internal frame as shown in figure 80. 
 

 
Figure 80. Screen Capture. SSAM Screen—Open Case Document from Workspace.  

 
Users can edit the case document information. To delete a .trj file from the case files 
section, click Edit. A confirmation message appears as shown in figure 81. 
 

 
Figure 81. Screen Capture. SSAM Screen—Confirm Delete Message. 

 
The message informs the user that all the data in the Conflict tab and Summary tab will 
be deleted. This means the Case Files section of a case document cannot be edited 
without discarding the conflict and summary information stored in the old document.  
 
Click Yes to activate the case files and the threshold sections for editing as shown in 
figure 82. 
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Figure 82. Screen Capture. SSAM Screen—Edit a Case Document. 

ale 
king avenue101.trj will be deleted from the case files section as shown in 

gure 83.  
 

 
To delete yale road & hocking avenue101.trj, select the file name then click Delete. Y
road & hoc
fi

 
Figure 83. Screen Capture. SSAM Screen—Delete a .trj File. 
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Click Apply to apply the changes to the case document. This will activate the Analyze 
button. The case document is now ready to be analyzed again with the new case files. 

ote that applying changes does not save the case document. In order to save the case 
ve or choose the Save option in the File menu. 

 

ts to 

t to disk. This section describes the robust features provided by the SSAM 
ftware filter. SSAM offers a robust filter which makes sure that the user sets the valid 

e 

software will inform the user that a case document must first be 
opulated with conflict data which can be filtered. Figure 84 shows the error message for 

this user input error. 
 

N
document, users must click Sa

Checking Filter Robustness 

SSAM is robust in terms of checking user input errors. For example, if a user attemp
close an unsaved case document, the software will prompt the user to save the case 
documen
so
filters.  
 
To apply a filter, click Apply Filter. When this button is clicked, SSAM checks if ther
is any data to which the filter can be applied. If the user attempts to apply a filter to 
nonexisting data, the 
p

 
Figure 84. Screen Capture. SSAM Screen—Error Message for Nonexisting Data. 

 
If the case document has been populated with conflict data, the SSAM software checks 

s: 
 

• 

on of 
t data that falls within a range for 

single or multiple surrogate measures. The filter thus allows the user to 
for surrogate measures. 

 
• 

end 

is means that the user can see all types of conflicts in the Conflict 
tab. The selection of any conflict type along with the ALL type is an invalid 
selection.  

for the following user input error

Surrogate Thresholds 
SSAM ensures that the user does not input invalid maximum and minimum 
values in the surrogate’s threshold section. The surrogate threshold secti
the filter allows the user to view conflic

specify ranges 

Conflict Types 
SSAM checks the user selection of the conflict types for the filter. The user 
can select multiple conflict types. For example, the user can select the rear 
and the lane change conflicts, which means that all rear end and lane change 
conflicts will be picked up in the Conflict tab. By default, the type ALL is 
selected. Th

72 



 

• Link types 
The user can select multiple links in the Links Types section of the filter. By 
default, the type ALL is selected. This means that the user can see conflict data 
for all the links in the Conflict tab. The selection of any link along with the 
ALL type is an invalid selection.  

 
If the tool finds all of the above filter errors, it will report all corresponding error 
messages. 
 

 
Figure 85. Screen Capture. SSAM Screen—Filter Tab Errors. 
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In figure 85 we can see the following errors in the filter settings:  
 

• Range for the PET surrogate measure is invalid. 

• The rear end conflict type is selected along with the ALL option. 

• Links 100014 and 10015 are selected with the ALL option. 

 
The following error message appears when the filter seen in figure 86 is applied. 
 

 

Figure 86. Screen Capture. SSAM Screen—Wrong Filter Settings Error Message. 
 
Null Result Filter 

Sometimes the filter settings applied by the user might not yield a result. For example, if 
there are no lane-change conflicts and the user wants to view only lane-change conflicts, 
no conflicts will be shown in the Conflict tab. In this case, the SSAM software will 
inform the user that the filter did not yield any results. However, the data in the Conflict 
tab and the Summary tab will remain unchanged. Figure 87 shows the message for this 
event. 
 

 

Figure 87. Screen Capture. SSAM Screen—No Results Error Message. 
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USABILITY 

This section will demonstrate the SSAM software’s ability to present documents in 
different ways. It will also describe the added functionality of exporting data from SSAM 
to a .csv format which can be viewed in Microsoft® Excel.  
 
In this example, two case documents—140 & 72_ssam and 184 & fraser_ssam—are 
open. Figure 88 shows three case documents in the workspace area and 140 & 72_ssam 
open.  
 
Working with the Tiling Options 

 
Figure 88. Screen Capture. SSAM Screen—Opening Case Documents. 
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The relevant information for the selected case document is seen in the internal frame. 
Notice in figure 88 that the name of the internal frame is the same as the name of the 
selected file. The SSAM software allows the user to view all open case documents at 
once. The user can tile the case documents in the following ways: 
 
Using the Horizontal Tiling 

To use horizontal tiling, click Horizontal tile in the toolbar. Users can also select 
Horizontal from the Window menu. Figure 89 shows three horizontally tiled case 
documents. 
 

 
Figure 89. Screen Capture. SSAM Screen—Horizontal Tiling. 
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Using the Vertical Tiling 

To use vertical tiling, click Vertical tile in the toolbar. Users can also select Vertical 
from the Window menu. Figure 90 shows three vertically tiled case documents. 
 

 
Figure 90. Screen Capture. SSAM Screen—Vertical Tiling. 
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Using the Grid Tiling 

To use grid tiling, click Grid tile in the toolbar. Users can also select Grid from the 
Window menu. Figure 91 shows three case documents tiled in a grid. 
 

 
Figure 91. Screen Capture. SSAM Screen—Grid Tiling. 
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Using the Cascade Tiling 

To use cascade tiling, click Cascade tile in the toolbar. Users can also select Cascade 
from the Window menu. Figure 92 shows three cascaded case documents. 
 

 
Figure 92. Screen Capture. SSAM Screen—Cascade Tiling. 

 
All the documents must be opened to be seen in a tiled view. Each of the case document 
frames can be resized; however, the elements inside the internal window of a case 
document will not be resized according to the size of the frame. This can be seen in the 
figures above. 
 
Toggling the Workspace Window 

SSAM also allows the user to toggling the workspace. This can be done by clicking 
Toggle Workspace on the toolbar or selecting Toggle Workspace in the Window menu. 
Figure 93 shows the tool when the workspace window is toggled out.  
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Figure 93. Screen Capture. SSAM Screen—Toggling the Workspace Window. 

 
Exporting Data  

SSAM allows the user to export the conflict data from the Conflict tab into a .csv file. 
Click Export to export the conflict data to a .csv file. Clicking the Export button will 
result in the file menu shown in figure 94. In this example, the export file is named 
export.csv. Click Save to save the file. 
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Figure 94. Screen Capture. Export Conflict Table to .csv File. 

 
Figure 95 shows the export.csv file when it is open in Microsoft® Excel. The first row of 
the .csv file is marked in figure 95 to show the column names as seen in the Conflict tab 
of the case document. 
 

 
Figure 95. Screen Capture. Microsoft® Excel—Exported .csv File. 



 

 



 

APPENDIX. TERMS AND DEFINITIONS 
 
This appendix serves as a glossary, defining several surrogate safety measures and other 
terms used within SSAM. 
 
Case document is a file which contains the required information for analyzing trajectory 
data. It also contains the result set of the analysis. The required information for creating a 
case document is as follows: 
 

• Name of the case document. 

• Name of analyst. 

• Comments.  

• Analysis date. 

• A list of trajectory files to be analyzed. 

• Threshold values (TTC and PET). 

 
All of the above are configured via the Configuration tab in the SSAM software. 
 
The result set obtained after analyzing a single or a group of trajectory files in the case 
document comprises of the following information: 
 

• List of conflicts. 

• List of summary data. 

 
A case document can be overwritten and saved. 
 
The following surrogate safety measures are ordered according to their column-wise 
appearance (from left-to-right) in the conflicts table on the Conflicts tab. 
 
trjFile is the name of the trajectory file (i.e.,.trj file) where this conflict was identified. 
 
tMinTTC is the simulation time where the minimum TTC (time-to-collision) value for 
this conflict was observed. At the beginning of each simulation, the time is (generally) 0 
and advances in increments of 0.1 to 1.0 seconds per time step depending on the 
resolution of the simulation software. 
 
xMinPET is the x-coordinate specifying the approximate location of the conflict at the 
time when the minimum PET (post encroachment time) was observed. More specifically, 
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this location corresponds to the center of the (first) vehicle, where the subsequent arrival 
of the second vehicle to the same location was the shortest encroachment observed.  
 
yMinPET is the y-coordinate specifying the approximate location of the conflict at the 
time when the minimum PET (post encroachment time) was observed. More specifically, 
this location corresponds to the center of the (first) vehicle, where the subsequent arrival 
of the second vehicle to the same location was the shortest encroachment observed.  
 
TTC is the minimum time-to-collision value observed during the conflict. This estimate 
is based on the current location, speed, and trajectory of two vehicles at a given instant. 
 
PET is the minimum post encroachment time observed during the conflict. Post 
encroachment time is the time between when the first vehicle last occupied a position and 
the second vehicle subsequently arrived at the same position. A value of 0 indicates an 
actual collision. 
 
MaxS is the maximum speed of either vehicle throughout the conflict (i.e., while the 
TTC is less than the specified threshold). This value is expressed in feet per second or 
meters per second, depending on the units specified in the corresponding trajectory file. 
 
DeltaS is the difference in vehicle speeds as observed at tMinTTC. More precisely, this 
value is mathematically defined as the magnitude of the difference in vehicle velocities 
(or trajectories), such that if v1 and v2 are the velocity vectors of the first and second 
vehicles respectively, then DeltaS = || v1 - v2 ||. Consider an example where both vehicles 
are traveling at the same speed, v. If they are traveling in the same direction, DeltaS = 0. 
If they have a perpendicular crossing path, DeltaS = (√2)v. If they are approaching each 
other head on, DeltaS = 2v.  
 
DR is the initial deceleration rate of the second vehicle. Note that in actuality, this value 
is recorded as the instantaneous acceleration rate. If the vehicle brakes (i.e., reacts), this is 
the first negative acceleration value observed during the conflict. If the vehicle does not 
brake, this is the lowest acceleration value observed during the conflict. This value is 
expressed in feet per second or meters per second, depending on the units specified in the 
corresponding trajectory file. 
 
MaxD is the maximum deceleration of the second vehicle. Note that in actuality, this 
value is recorded as the minimum instantaneous acceleration rate observed during the 
conflict. A negative value indicates deceleration (braking or release of gas pedal). A 
positive value indicates that the vehicle did not decelerate during the conflict. This value 
is expressed in feet per second or meters per second, depending on the units specified in 
the corresponding trajectory file. 
 
MaxDeltaV is the maximum DeltaV value of either vehicle in the conflict (see 
FirstDeltaV or SecondDeltaV for more information).  
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ConflictAngle is an approximate angle of hypothetical collision between conflicting 
vehicles, based on the estimated heading of the each vehicle (see explanation of 
FirstHeading). The angle, expressed in the perspective of the first vehicle to arrive at the 
conflict point, conveys the direction from which the second vehicle is approaching the 
first vehicle, as shown in figure 96. The angle ranges from -180 ° to +180 °, where a 
negative angle indicates approach from the left and a positive angle indicates approach 
from the right. An angle of 180 ° (or -180 °) indicates a direct head-on approach, and an 
angle of 0 ° (or -0 °) indicates a direct rear approach. 
 

 

Figure 96. Illustration. Conflict Angle. 

 
ClockAngle is an alternative expression of the conflict angle in terms of a more familiar 
clock hand positions. Again, the angle is expressed in the perspective of the first vehicle, 
with the clock time indicating the angle from which the second vehicle is approaching, as 
shown in figure 97. The 12:00 position is direct ahead of the first vehicle, 3:00 is to the 
right, 6:00 is directly behind, and 9:00 is to the left. 
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Figure 97. Illustration. Clock Angle. 

ConflictType describes whether the conflict is the result of a rear end, lane change, or 
crossing movement. If link and lane information is not available for both vehicles, then the 
event type is classified based solely on the absolute value of the ConflictAngle as follows. 
The type is classified as a rear-end conflict if ||ConflictAngle|| < 30 °, a crossing conflict if 
||ConflictAngle|| > 85 °, or otherwise a lane-changing conflict. However, the simulation 
model that produced the vehicle trajectory data can generally provide link and lane 
information for both vehicles—though the coding of these values may vary significantly from 
one simulation vendor to the next. If link and lane information is available, that information is 
utilized for classification in the case that the vehicles both occupy the same lane (of the same 
link) at either the start or end of the conflict event. If the vehicles both occupy the same lane at 
the start and end of the event, then it is classified as a rear-end event. If either vehicle ends the 
conflict event in a different lane than it started (while having not changed links), then the event 
is classified as a lane-change. If either of the vehicles changes links over the course of the 
event, then the conflict angle determines the classification as previously described, with the 
following possible exception). For two vehicles that begin the conflict event in the same lane, 
but change links over the course of the event, the classification logic considers only rear-end 
or lane-change types, based on the conflict angle (using the threshold value previously 
mentioned). Note that vehicle maneuvers such as changing lanes into an adjacent turn bay lane 
or entering into an intersection area may be consider changing links, depending on the 
underlying simulation model. In some cases, vehicles which appear to be traveling in the same 
lane may actually by considered by the simulation model as traveling on different links that 
happen to overlap.  

PostCrashV is an estimate of the post collision velocity of both vehicles. This estimate 
assumes that the vehicles did crash, at the estimated ConflictAngle, at velocities 
observed at the tMinTTC, and assuming an inelastic collision between the center of mass 
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of both vehicles, where both vehicles subsequently deflect in the same direction and at 
the same velocity. 
 
PostCrashHeading is the estimated heading of both vehicles following a hypothetical 
collision (as discussed in PostCrashV). This heading is expressed as the angle measured 
counterclockwise from the x-axis (which is assumed to point right), such that 0 ° is right, 
90 ° is up, 180 ° is left, and 270 ° is down. The angle ranges from 0 ° to 360 °. 
 
FirstVID (SecondVID) is the vehicle identification number of the first (second) vehicle. 
The first vehicle is the vehicle that arrives to the conflict point first. The second vehicle 
subsequently arrives to the same location. In rare cases (actually collisions) both vehicles 
may arrive to a location simultaneously, in which case the tie between first and second 
vehicle in broken arbitrarily. 
 
FirstLink (SecondLink) is a number indicating which link the first (second) vehicle is 
traveling on at tMinTTC. 
 
FirstLane (SecondLane) is a number indicating in which lane the first (second) vehicle 
is traveling on at tMinTTC. 
 
FirstLength (SecondLength) is the length of the first (second) vehicle in feet or meters. 
 
FirstWidth (SecondWidth) is the width of the first (second) vehicle in feet or meters. 
 
FirstHeading (SecondHeading) is the heading of the first (second) vehicle during the 
conflict. This heading is approximated by the change in position from the start of the 
conflict to the end of the conflict. Note that in most non-rear-end conflicts, at least one 
vehicle is turning throughout the conflict. Its actual heading would vary accordingly 
throughout the conflict. If the vehicle does not move during the conflict, then the 
direction in which it is facing is taken as the heading. This heading is expressed as the 
angle measured counterclockwise from the x-axis (which is assumed to point right), such 
that 0 ° is right, 90 ° is up, 180 ° is left, and 270 ° is down. The angle ranges from 0 ° to 
360 °. 
 
FirstVMinTTC (SecondVMinTTC) is the velocity (speed) of the first (second) vehicle 
at tMinTTC.  
 
FirstDeltaV (SecondDeltaV) is the change between conflict velocity (given by speed 
FirstVMinTTC and heading FirstHeading) and the post-collision velocity (given by 
speed PostCrashV and heading PostCrashHeading). This is a surrogate for the severity 
of the conflict, calculated assuming a hypothetical collision of the two vehicles in the 
conflict. 
 
xFirstCSP (xSecondCSP) is the x-coordinate of the first (second) vehicle at the conflict 
starting point (CSP). The CSP is the location of the vehicle at tMinTTC. 
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yFirstCSP (ySecondCSP) is the y-coordinate of the first (second) vehicle at the conflict 
starting point (CSP). The CSP is the location of the vehicle at tMinTTC. 
 
xFirstCEP (xSecondCEP) is the x-coordinate of the first (second) vehicle at the conflict 
ending point (CEP). The CEP is the location of the vehicle at either the last time step 
where the TTC value is below the specified threshold or where the last post-
encroachment value was observed, whichever occurs later in the conflict timeline. 
 
yFirstCEP (ySecondCEP) is the y-coordinate of the first (second) vehicle at the conflict 
ending point (CEP). The CEP is the location of the vehicle at either the last time step 
where the TTC value is below the specified threshold or where the last post-
encroachment value was observed, whichever occurs later in the conflict timeline. 
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